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一、 仪器结构和功能介绍 

仪器主要结构： 

高分辨环境控制原子力显微镜主要构造包含了扫描器、控制器、CCD、电脑软件等 

 

仪器功能： 

通过检测待测样品表面和一个微型力敏感元件之间的极微弱的原子间相互作用力来研究物质的表面结构及性质。除

了获取表面形貌的信息，还可以通过不同模块测试样的热学、电学、磁学、力学、光学、电化学等物理性质。 

 

二、 注意事项 

1. 探针下降的速度随着扫描台升降旋钮幅度的变大而变快，建议初学者仅小幅度的扭动旋钮，以防探针撞到样品

上，严重的甚至可能损坏设备； 

2. 样品尺寸直径小于 15mm，高度小于 7mm，粗糙度小于 5μm； 

3. 一般不推荐使用双面胶固定样品，因为双面胶会引起倾斜，蠕变，固定不牢固等问题，推荐使用 AB 胶，导电银

胶，热熔胶等; 

 

三、 探针和样品的安装 

1. 确认控制器电源，激光开关以及软件全部打开； 

2. 打开隔音罩的门，将扫描器右侧固定杆（黑色把手）往抬起，轻轻将扫描器往外拉出 2/3 并固定； 

3. 用内六角旋松固定螺丝，双手按住 holder 两侧的把手轻轻逆时针旋转 10°左右，然后将 holder 拔出； 

控制器 

CCD 

扫描器 

电脑 

扫描台升降旋钮 

控制器电源 

激光光源开关 
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4. holder 底面朝上放置在平台上，将固定螺丝旋松； 

5. 用镊子轻轻夹取探针侧边，将探针塞入夹片的缝隙中，再固定； 

  

6. 把样品粘在样品台上（推荐使用 AB 胶，导电银胶，热熔胶等固定），然后用镊子放置于扫描台上，再逆时针旋

转扫描台升降旋钮将扫描台往下移动一段距离（以防安装 holder 时与样品发生碰撞，损坏探针）； 

  

7. 把 holder 放置于初始位置，轻轻往下压，然后顺时针旋转 10°左右，固定； 

8. 将扫描器推回初始位置，并将其右侧的固定杆拉下，确认物镜的聚焦矫正环对应在 1.5 的位置，关上隔音罩； 

9. 逆时针旋转扫描台高度调整旋钮将扫描台往上移动，直至探针下降至样品表面 1~2mm 左右的位置； 

固定螺丝 

固定螺丝 探针 

固定杆 
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四、 接触模式 

1. 软件选择 Contact Mode，进入接触模式的操作页面； 

 

2. 在 Video 窗口（若此窗口没有自动弹出，则点击软件下方的照相机 LOGO 的图标）中点击 Home 键，此时应大

致可以看到悬臂梁的轮廓，或者可以判断出悬臂梁视场的位置，借助 Video 窗口左上角的一组箭头（CCD 移动

光标）将悬臂梁放在视场范围内，再通过 Move Focus 的上下箭头将悬臂梁尖端调节至最为清晰； 

物镜 

holder 
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3. 可借助 Video 窗口左上角的移动箭头将激光光斑移动至悬臂梁上（按住 Shift 键可实现微调），或者将鼠标移至

悬臂梁上右击，再点击 Spot on，激光光斑自动移至悬臂梁上；当激光光斑移动至悬臂梁上时，在 Sum and Deflection 

Meter 窗口“Sum”值会发生变化，当“Sum”值大于 3 时，方可进行测试； 

 

4. 在 Engage Panel 窗口中点击 Focus on Tip 右侧的“SET”→继续向下调节聚焦，直至聚焦在样品表面上，点击 Focus 

on Sample右侧的“SET”→点击Move to Pre-Engage，将探针移至离样品表面50μm的位置→点击Sum and Deflection 

Meter 窗口的 Zero PD 使 Deflection 清零（接近 0 即可）； 

CCD 移动光标 

放大倍率 

调节亮度 

调节曝光量 

激光光斑 
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5. 通过 Video 窗口的样品台移动箭头来移动样品，确认需要扫描的区域→点击 Engage Panel 窗口中的 Start Tip 

Approach 开始自动下针，下针成功后会有警示音发出； 

6. 在 Master Panel 窗口设置扫描参数；之后再点击 Frame up/down 开始扫描； 

 

7. 扫描过程中参数的调节。扫描过程中应观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重合，表

明此时的扫描参数设置的合理，不需要进一步调节。如果红蓝线并不重合，可以尝试如下几步： 

a) 增加探针的力的大小，即增大 Setpoint 值。注：虽然加大力往往能提高扫图质量，但过大的力也会加剧探针

的磨损以及对样品的破坏；（硬的探针 Setpoint 值一般不超过 0.2） 

b) 增加反馈系统的灵敏度，即增大 Integral Gain 值。注：过大的 I Gain 值会引起系统震荡，体现为图中出现明

显波纹状噪音; 

样品表面 

探针 
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c) 降低扫描速率即 Scan rate； 

d) 若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨损，尝试更换新的探

针； 

 

8. 扫描结束后，点击 Stop，再点击 Engage Panel 窗口中的(Un)Load Sample 退针，取下探针，收起样品，关上激光

并关上软件。若近期内仍需要使用 AFM 则无需关闭控制器和电脑工作站； 

 

五、 轻敲模式 

1. 软件选择 AC Air Topography，进入轻敲模式的操作页面； 

 

2. 在 Video 窗口（若此窗口没有自动弹出，则点击软件下方的照相机 LOGO 的图标）中点击 Home 键，此时应大

致可以看到悬臂梁的轮廓，或者可以判断出悬臂梁视场的位置，借助 Video 窗口左上角的一组箭头（CCD 移动

光标）将悬臂梁放在视场范围内，再通过 Move Focus 的上下箭头将悬臂梁尖端聚焦调节至最为清晰； 

I Gain 值过大引起自激震荡 
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3. 可借助 Video 窗口左上角的移动箭头将激光光斑移动至悬臂梁上（按住 Shift 键可实现微调），或者将鼠标移至

悬臂梁上右击，再点击 Spot on，激光光斑自动移至悬臂梁上；当激光光斑移动至悬臂梁上时，在 Sum and Deflection 

Meter 窗口“Sum”值会发生变化，当“Sum”值大于 3 时，方可进行测试； 

 

4. 在 Engage Panel 窗口中点击 Focus on Tip 右侧的“SET”→继续向下调节聚焦，直至聚焦在样品表面上，点击

样品台移动光标 聚焦调节箭头 

探针悬臂梁 
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Focus on Sample 右侧的“SET”→点击 Move to Pre-Engage，将探针移至离样品表面 50μm 的位置→点击 Sum 

and Deflection Meter 窗口的 Zero PD 使 Deflection 清零（接近 0 即可）； 

 

5. 寻峰/Tune，即寻找所用探针的共振频率并设置空气的 Free amplitude 值(Target Amplitude)。点击 Master Panel

面板中的 Tune→点击 Cantilever Tune 面板中的 Parms→根据所选探针盒信息设置频率范围以及  Target 

Amplitude→点击 Cantilever Tune 面板中 Auto Tune 即可； 

 

6. 在 Master Panel 窗口设置扫描参数，Set Point 值一般设为 Target Amplitude 值的 80%；Setpoint 和悬臂的自由振

幅 Free Amplitude（即为 Auto Tune 步骤中设置的 Target Amplitude）的比值体现扫图过程中探针力的大小，所以

Setpoint 的值必须设置为小于自由振幅 Free Amplitude 的值。但是由于在通常在 Auto Tune 时将自由振幅设为 

1V，所以可以近似理解为 Setpoint 值越小，探针施加的力越大，反之亦然； 

 

 

 

 

 
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7. 点击 Engage Panel 面板中的 Start Tip Approach 开始自动下针，下针成功后会有警示音发出→点击 Sum and 

Deflection Meter 面板中的 Engage→减小 Setpoint 值至 Z Voltage 值基本不变化（如果 Z Voltage 为 150，重复

步骤，直至 Z Voltage 小于 150）→点击 Frame up/down 开始扫描； 

8. 扫描过程中参数的调节。扫描过程中应观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重合，表

明此时的扫描参数设置的合理，不需要进一步调节。如果红蓝线并不重合，可通过 

a) 增加探针的力的大小，即减小 Setpoint 或者增大 Drive Amplitude。 

b) 增加反馈系统的灵敏度，即增大 Integral Gain 值。注：过大的 I Gain 值会引起系统震荡，体现为图中出现明

显波纹状噪音; 

c) 降低扫描速率即 Scan rate； 

d) 若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨损，尝试更换新的探

针； 

 

9. 扫描结束后，点击 Stop，再点击 Engage Panel 窗口中的(Un)Load Sample 退针，取下探针，收起样品，关闭激光； 
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六、 液相轻敲模式 

1. 软件选择 AC Air Topography，进入轻敲模式的操作页面； 

 

2. 装样和装针。将样品放在 Scanner 的样品台上，使用移液枪滴加适量液滴（通常为 100uL 左右），覆盖样品表面，

液滴直径不要超过 1cm，使得基底和 Holder（探针夹持器）之间形成一个液体的环境即可。使用移液枪在针尖位

置滴一滴相同的液体，确保液体可以完全覆盖悬臂部分，这样做可以防止下针后悬臂周围出现气泡； 

 

3. 将 Scanner 推回初始位置，并将其右侧的黑色把手拉下，向右旋转物镜的（聚焦矫正环），将其对应在 2.0 的位

置，关上隔音罩； 

4. 将激光光斑移至探针悬臂梁上，在 Engage Panel 窗口中点击 Focus on Tip 右侧的“SET”→继续向下调节聚

焦，直至聚焦在样品表面上，点击 Focus on Sample 右侧的“SET”→点击 Move to Pre-Engage，将探针移至离样

品表面 50μm 的位置；因液体会产生折射，样品表面的实际高度会受影响，多次重复步骤，直至点击 Focus 

on Sample 后，可以清晰观察到样品表面； 
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5. 寻峰/Tune。即寻找所用探针的共振频率并设置接触样品前的 Free amplitude (Target Amplitude)，由于液体分子和

悬臂的相互作用导致在液体环境中寻峰会有很多杂峰，所以在液体环境中寻峰应使用手动寻峰 Manual Tune； 

 

6. 点击 Cantilever Tune 窗口中的 Adv.，然后勾选 Append Thermal→将 Sweep Width 改成 30kHz，点击 Tune→结合

Thermal 图（红色点）选择合适的峰，点击右键选择 Set Drive Frequency→调节 Drive Amplitude 直到 Sum and 

Deflection Meter 窗口的 Amplitude 的值达到期待值（通常对于大部分生物样品的液相扫描，应选用较小的 Free 

Amplitude 0.7~0.9V；而对于比较硬的材料和比较黏的样品则建议使用较大的 Free Amplitude 2V）→再次点击

Tune 和 Center Phase，并将 Set point 设为 Free  Amplitude 值的 80%； 

 

7. 点击 Engage Panel 面板中的 Start Tip Approach 开始自动下针，下针成功后会有警示音发出→点击 Sum and 

Deflection Meter 面板中的 Engage→减小 Setpoint 值至 Z Voltage 值基本不变化（如果 Z Voltage 为 150，重复

步骤，直至 Z Voltage 小于 150）； 

8. 在 Master Panel 窗口设置扫描参数→点击 Frame up/down 开始扫描； 

 

空气中的共振频率 溶液中的共振频率 
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9. 描过程中参数的调节。扫描过程中应观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重合，表明

此时的扫描参数设置的合理，不需要进一步调节。 

a) 如果红蓝线并不重合，可通过增加探针的力的大小，即减小 Setpoint 或者增大 Drive Amplitude。 

b) 增加反馈系统的灵敏度，即增大 Integral Gain 值。注：过大的 I Gain 值会引起系统震荡，体现为图中出现明

显波纹状噪音; 

c) 降低扫描速率即 Scan rate； 

d) 若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨损，尝试更换新的探

针； 

10. 扫描结束后，点击 Engage Panel 中的(Un)Load Sample 退针，取下探针，收起样品，关上激光并关上软件； 

11. 取探针时，可先用滤纸尖端将液滴吸干。取下后将 Holder 与样品台加入无水乙醇或去离子水，用棉签小心擦拭，

清洁后将 Holder 取下用压缩空气吹干。 

 

七、 光热激发模块（用于轻敲模式） 

1. 安装 Blue Drive 模块。 

 

2. 打开轻敲模式，将激光光斑移至探针悬臂梁上，并把探针移至样品表面 50μm 的位置；点击 Zero PD 使 Deflection

清零（具体方法可参考轻敲模式）； 

光热激光模块安装位置 

不同输出功率的模块 
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3. 点击 Master Panel 面板中的 Tune→点击 Cantilever Tune 面板中的 Adv.→将 Tune Drive 更改为 Blue Drive（第一

次安装光热模块时默认为 Calibration），这样 Blue Drive 就开启了； 

 

4. Blue Drive 打开后，Video 窗口右上角的 Blue 移动光标就激活了，通过移动光标将蓝光光斑移至悬臂梁上，或者

将鼠标移至悬臂梁上右击，再点击 Blue Spot on 蓝光光斑自动移至悬臂梁上；通过移动光标将 Amp（MV）值调

整至最大即可（一般将蓝光光斑移至针尖左侧边缘位置）； 
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5. 寻峰/Tune，点击 Cantilever Tune 页面的 Parms，设置频率和 Target Amplitude；再点击 Auto Tune； 

 

6. 在 Master Panel 窗口设置扫描参数后即可开始扫描（具体方法请参考轻敲模式）； 

 

八、 导电测试模块 

1. 需要导电探针和使用导电 Holder（编号为 3）；同时还应确认样品台和 Scanner 间有一根黑色导线连通，如下图 

 

蓝光移动光标 

蓝光光斑 

激光光斑 
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2. 导电样品的制备。选择导电样品台，在上面涂上少量导电银浆，然后将固定好样品的普通样品台放置于导电样品

台上，并在样品与导电样品台之间涂上少量导电银浆，待导电银浆固化后，可以万用表确认样品和引线是否接通

导电； 

  

3. 使用标准电阻做一个 I-V 曲线，以判断机器状态是否正常。将标准电阻一端固定在导电 Holder 探针位置，另外

一端固定在扫描台上磁力电极上；选择 Electrical/Orca 模式，进入后在 AR Do IV Panel 界面直接点击 Do It，I-V 

曲线收集完后会直接显示在软件中，计算曲线斜率，和标准电阻的阻值（标准电阻阻值为 500MΩ）进行比较，

以判断机器是否正常工作。 

  

 

4. 确认机台无异常后，在导电 Holder 安装上导电探针，并将导电样品台放置于扫描台上，引线的一端接在扫描台

的磁力电极上（最外侧的电极柱）；可万用表确认样品和磁力电极是否接通导电； 

标准电阻 
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5. 安装导电 Holder，关上隔音罩，打开导电测试模块 Orca，采用 Contact Mode 的方式下针（具体方法请参照接触

模式）； 

6. 勾选 AR Do IV Panel 页面中的 Use→点击 Zero，将 Cur（nA）归零→电流基线校准（先开始扫描，通过设置 Sample 

Voltage 的电压值，将电流值的基线调至 0 附近，然后将电压值输入 S.Voltage Offset 的选项内）； 

 

7. 勾选 AR Do IV Panel 页面中的 Use，在 Master Panel 窗口设置扫描参数；之后再点击 Frame up/down 开始扫描，

通过控制 Sample Voltage 的电压值调节 Current 页面中的电流，电流值≤20nA 为宜； 

8. 对特定位置进行导电测试。点击 Stop 停止扫描→勾选 Show Markers 和 Show Tip→点击 Pick Points，移动图上的

光标选择需要测试的点位→再点击 That’s It，重复多次，在图上做好标记→在 Spot number 输入需要测试的位置，

磁力电极 
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点击 Go there； 

  

9. 可通过 Function 选择不同类型的电压并设置好 Amplitude、Frequency 以及 Cycles； 

  

移动光标 

电压类型 
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10. 勾选 Feedback On，点击 Do it，即可得到对应点的 I-V 曲线 

 

11. 测试对应位置的力曲线。在 Spot number 输入需要测试的位置，点击 Go there→勾选 Apply During Triggered Force 

Plots→在 Master Panel/Force 页面中，设置好 Trigger Point→点击 Single Force 即可得到力曲线和 I-V 曲线； 

 

九、 SKPM/KPFM 模式 

1. 无需额外配件，只需要导电探针和标准 Holder 即可； 

2. 在标准 Holder 上安装导电探针；将样品固定在样品台上，为扫描过程中使电场更均匀，还需将样品接地。接地

方法如下，使用带有导线的 AFM 样品台，确认样品和铁片表面是导通的（可用导电银浆或者导电胶），必要时

可用万用表检测，将导线吸在样品腔右侧的中间位置的电极柱即可；还应确认样品台和 Scanner 间有一根黑色导

线连通，如下图； 

 

3. 软件选择 SKPM，进入轻敲模式的操作页面； 

 

4. 将激光光斑移至探针悬臂梁上，并把探针移至样品表面 50μm 的位置；点击 Zero PD 使 Deflection 清零（具体方

法可参考轻敲模式）； 

5. 寻峰 Tune，寻找找所用探针的共振频率并设置 Set Point 值；（具体方法可参考轻敲模式）； 

电流值已饱和，可降低电压值 
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6. 点击 Engage Panel 面板中的 Start Tip Approach 开始自动下针，下针成功后会有警示音发出→点击 Sum and 

Deflection Meter 面板中的 Engage→减小 Setpoint 值至 Z Voltage 值基本不变化（如果 Z Voltage 为 150，重复

步骤，直至 Z Voltage 小于 150）→点击 Sum and Deflection Meter 面板中的 Withdraw； 

7. 在 Electric Tune 窗口下，将 Trigger Point 设置为 Free Amplitude 的值（即为下针后的 Set point 值），点击Single 

Force，此时探针停留在离样品表面比较近的地方；  

 

8. 依次点击，并观察 Electric 中的 Phase Offset 值，通常此数值为 150°~180°之间； 

9. 在 Master Panel 页面中设置好扫描参数，点击 Frame up/down 开始扫描。扫描过程中参数的调节。扫描过程中应

观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重合，表明此时的扫描参数设置的合理，不需要

进一步调节。如果红蓝线并不重合，可通过 

a) 增加探针的力的大小，即减小 Setpoint 或者增大 Drive Amplitude。 

b) 增加反馈系统的灵敏度，即增大 Integral Gain 值。注：过大的 I Gain 值会引起系统震荡，体现为图中出现明显波

纹状噪音; 

c) 降低扫描速率即 Scan rate； 

d) 若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨损，尝试更换新的探针； 

10. 在得到较为高质量的形貌图后，再调节 Potential 图； 

a) 调节 Electric Tune Panel 页面中的 Potential I Gain 和 P Gain，其调节方式和普通形貌图的 I Gain 值一样，数值越

大红蓝曲线应越趋于重合，但如果数值设置的过高则会造成反馈系统发生震荡，图中出现波纹状噪音可以逐渐

降低 Nap Panel 页面中的 Delta Height，直到 Potential 图中图像清晰且不受形貌图的影响； 

b) 适当增加 Electric Tune Panel 页面中的 Drive Amplitude，可改善 Potential 图的质量； 
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11. 扫描结束后，点击 Stop，再点击 Engage Panel 窗口中的(Un)Load Sample 退针，取下探针，收起样品，关闭激光。 

 

十、 力曲线 

1. 可根据下表选择合适的探针； 

 

2. 软件选择 Contact Mode Force，进入力曲线测试模式的操作页面；  

 

3. 将激光光斑聚焦在探针的悬臂梁上； 
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4. 对探针进行校准，得到准确的 InvOLS（反光杠杆灵敏）值和 k（弹性系数）值。点击 Master Panel 页面的 Thermal→

点击 Thermal Graph 页面的 GetReal→选择所使用的的探针型号→点击 GetReal Calibration，系统会自动完成探针

的校准； 

 

5. 校准完成后，在 Master Panel 页面的将 Image 切换至 Force，点击 Cal，Cal 页面中 Defl InvOLS、Amp InvOLS 以

及 Spring Constant 的值会自动更新，并且圆形红色记号会变为绿色； 

 

6. 通过接触模式，对样品进行扫描（具体方法请参照接触模式）； 

7. 样品表面扫描完成后，点击 Stop； 

8. 在 Master Panel/Force 页面中，切换至 Go There 页面，勾选 Show Markers 和 Show Tip、Withdraw During Movement，

此时在每个图像频道窗口，会出现一个圆形光标，点击 Pick Point，这时点击图像上圆形光标就可以任意移动，

拖曳至感兴趣的位置，再点击 That’s It，这样就标记完成了，如此循环，对图像上的需要测试的位置进行标记； 
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9. 标记完成后，Spot number 输入需要测试位置的记号数，点击 Go There，探针就会移动至标记位置，设置好 Trigger 

Channel 和 Trigger Point，点击 Single Force 即可得到力曲线； 

 

10. 力阵列测量。切换至 Master Panel/Famp 页面中，根据所需设置好参数，在 Force Points/Force Lines（横向测试次

数/纵向测试次数）输入阵列数量，点击 Do Fmap，即可得到图上每个阵列的力曲线，测试完成后，点击 Force 

Map 面板上的阵列，就会显示对应阵列的力曲线； 
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11. 对多个标记点进行快速测试。在软件页面主目录 Programming 中打开 MacroBuilder 进行程序编辑，编辑好之后，

在 Number of times through loop 输入测试次数，点击 Run 测试即可； 
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12. 力曲线的分析。 Master Force Panel 可以方便、快速而准确的将力曲线结合多种数学模型进行拟合，以定量的分

析材料的力学特性，尤其是杨氏模量。在导入需要分析的力曲线后，用户需要根据样品自身的特性，选择相应的

数学模型，如 Hertz， JKR 等，这一步骤需要用户对于纳米力学学科有一定的积累，选择好数学模型后，用户仅

需进一步在界面左下角填入相关参数即可。注：不同的数学模型在此处需填入不同的参数，此时软件会在 Results

处直接给出样品的杨氏模量值。 
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可以选择分析单一力曲线或整个力曲线阵列图；在 Segment 还可以选择分析不同阶段的力曲线； 

显示的为校准的探针的 InvOLS（反光杠杆灵敏）值和 k（弹性系数）值； 

这个区域会提示力曲线在拟合计算过程发现的异常。点击黄色字体可进入帮助部分，该部分描述了异常所代表的

含义以及如何在解决这个问题； 

 该部分对力曲线进行分析，据此选择合适的模型进行拟合计算； 

 
选择相关的模型进行拟合计算； 
这个区域你需要详细确认所使用探针的几何结构、类型、泊松比、杨氏模量和样品的泊松比； 

这部分根据弹性模型进行模拟，可以输入适合参数并观察计算值如何改变； 

计算结果。 
 

十一、 快速力谱成像模块 

1. 软件选择 Fast Force Mode，进入快速力谱模式的操作页面； 

 

2. 点击 GetStarted Panel 的 Scan Parms，根据样品设置扫描范围、图像分辨率、预计样品粗糙度、Z 轴运动速率、

SetPoint（此时 Setpoint 即为力曲线中的 Trigger Point，即探针向样品施加的力达到此数值后探针抬起）、 Force 

Distance（做完一根力曲线时探针抬起的高度，也相当于下一根力曲线在 Z 方向的初始位置）等信息 
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3. 探针校准。点击 Probe Panle，在 Probe Panel 页面中选择所使用的探针的类型，点击 Continue GetStarted 即可；

校准完成后，点击 Probe Selected； 

 

4. 将激光光斑移至探针悬臂梁上，并把探针移至样品表面 50μm 的位置；点击 Zero PD 使 Deflection 清零（具体方

法可参考轻敲模式）； 

5. 样品表面和探针位置校准。点击 Engage Panel 面板中的 Focus On Tip→点击 GetStarted Panel 面板中的 Tip is 

Focused→点击 Engage Panel 面板中的 Focus On Sample→点击 GetStarted Panel 面板中 Sample Focused； 
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6. 最后确认激光光斑是否聚焦在探针悬臂梁上再点击 Laser Aligned，开始自动测试； 

 

7. 测试过程中在 Fast Force Map Viewer 面板中，可实时显示测试区域的力曲线变化；如果测试中断，无法显示力曲

线，可在 Master Panel 面板中适当增大 Z Rate，再点击 Frame up/down 重新开始扫描；  
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8. 扫描过程中软件会自动显示出四个频道的图像，分别为：1.Ht/Height，形貌图、2.Ad/ Adhesion，粘附力图、3.Fc/Max 

Force，误差信息，相当于接触模式下的 Deflection 图，突出样品表面形貌特征、4.Eh，杨氏模量，用户可以自

行选择数学模型并输入相关信息，以得到准确的杨氏模量信息。 

 

十二、 AMFM 模式 

AM-FM 技术结合了普通的振幅调制轻敲模式（AM mode）和灵敏度较高的频率调制模式（FM mode）。在操作

过程中，有两个不同频率的信号同时被用于激发探针，因此也需要两个反馈回路同时工作。其中一个反馈回路用于普

通振幅调制轻敲模式，即为检测并收集样品形貌信息；而另一个反馈回路则作用于同时加在探针上的第二个高频信

号，使其稳定在 90°，从而更精准的检测并收集样品的力学特性。 

1. 无需额外配件，只需要标准探针和标准 Holder 即可，可根据下图选择合适的探针； 
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2. 按照常规测样的方式固定样品以及装配探针； 

3. 软件选择 AMFM 模式，进入如下操作页面； 

 

4. 将激光光斑移至探针悬臂梁上，并把探针移至样品表面 50μm 的位置；点击 Zero PD 使 Deflection 清零（具体方

法可参考轻敲模式） 

5. 校准探针。在 Master Panel 中选择 Thermal----GetReal，在弹出的窗口选择本次实验使用的探针，点击 GetReal 

Calibration（具体操作见下图）软件将自动对探针的力学特性进行校准。 

 

6. 探针校准完成后 AMFM Panel 的“1.Calibrate & Tune”应更新显示探针的力学常数（如下图右图），用户可以比对

探针的参数检查校准是否准确； 

 
7. 寻峰/Tune，在 Master Panel 中选择 Tune，点击弹出窗口左侧的 Auto Tune（注：这一步只是为了下针，因此只需

将本征共振峰找到即可）；Setpoint 值下针前改为 1.6V； 
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8. 此时可以点击 Video 窗口标绿的一组箭头来移动样品，将感兴趣的区域移至探针下方。点击 Engage Panel 中的

“Start Tip Approach”开始自动下针，下针成功后会有警示音发出。 

9. 在 Master Panel 中选择 Force Panel，将 Force Dist 设置为 500nm,点击窗口下方的 Single Force，这一步的目的是

通过做力曲线，使探针停留在样品表面 500nm 的位置。 

 

10. 分别点击下图左右两个 Auto Tune 再次寻峰，由于此时探针离样品较近，可以避免 phase 值在扫图前再发生变

化。在这一步要确保 Phase1 和 Phase2 都被设置为 90°，如果有偏差可以多次点击 90°的图标。注： Auto Tune 前

应确认两 Target Amplitude 分别为 2V 和 25mv。 

 

11. 扫描参数设置好后，点击 Frame up/down 开始扫描。调节 Height Retrace 窗口下的红蓝线，使之重合。 

12. 扫描过程中参数的调节。 

a) Height Retrace 窗口下的红蓝线调节方式参照轻敲模式； 

b) 扫描过程中应确保 Sum and Deflection Meter 中的 Phase1 远小于 90°（通常为 40°左右），即探针时刻处于斥

力区间。如果不能实现则需要增大 Drive amplitude 知道 Phase1 值稳定与 40°左右； 

c) 观察 Frequency 和 Dissipation 等几个窗口下的红蓝线，若其非常不重合则需手动调节 Frequency & Dissipation 

Gains。这几个值通常由系统自动设置，若需手动调节，请见下图。 首先点击 AMFM Panel 中的 Parms，在

弹出来的右侧窗口中不勾选 Auto Calculate Gains 前的小方块，然后即可手动调节下面的几个 Gain 值，主要
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调节 Freq I Gain 和 Drive I Gain 即可。注：这两个 Gain 值可以设置为很大的值（10~10000）； 

 

d) 在 AMFM  Panel 中还可手动选择用于计算杨氏模量的拟合模型和探针半径参数，用于更准确的检测样品

的力学性能； 

 

13. 建议用户在测量未知样品前先准备一个已知杨氏模量的标样，且其杨氏模量应与未知样品近似。首先使 AMFM

技术对标样进行扫描，在扫描的时候不断调整 Tip Radius，知道 Young’s Modulus 窗口的数值和标样的已知杨氏

模量相等，将此 Radius 值记下。换上待测的未知样品，使用相同的探针，在 AMFM 模式下扫图，输入刚才记下

的 Radius 值，此时 Young’s Modulus 窗口反应的应该就是样品的真实力学特性了。 

14. 扫描结束后，点击 Stop，再点击 Engage Panel 窗口中的(Un)Load Sample 退针，取下探针，收起样品，关闭激光。 

 

十三、 加热模块 

1. 更换加热模块。 

a) 关闭激光光源和控制器电源； 

b) 打开扫描器隔音罩，将扫描器拉出并固定； 

c) 将 holder 取下，并将扫描台上的连接线拔下； 

d) 用内六角螺丝刀旋松扫描台正面和侧面的固定螺丝； 

e) 将标准模块扫描台取出后，更换成加热模块扫描台； 

f) 先将加热模块扫描台电源接线从通孔，在固定扫描台底座的时候，可以轻轻按压四周的金属圈进行固定，不

要按压陶瓷片，以防损坏陶瓷片 

g) 安装好加热模块扫描台后，连接电源接线； 

h) 打开控制器电源和激光光源； 

  

侧面固定螺丝 
正面固定螺丝 
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2. 开启软件，打开任一操作模式，对升降台进行初始化； 

3. 在软件项目栏选择 AFM Controls → Environmental Panel，进入操作页面； 

  

4. 设置加热温度和升温速率，将 Mode 和 Feedback 切换至 On，加热台开始升温； 

5. 勾选 Collect data，点击 Live Graph，可以查看升温曲线； 

加热模块扫描台 

陶瓷片 

电源接线 
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6. 当温度达到设定温度后，即可进行其他模式的测试； 

7. 在高温条件下进行测试时，选择无镀层的纯硅探针，否则镀层在高温会变形以致损坏探针，激光总量无法达到系

统测试要求； 

8. 测试完成后，将 Mode 和 Feedback 切换至 Off，加热台开始降温； 

 

10. 当温度将至室温后，取下探针，收起样品，关闭激光； 
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十四、 光照模块 

此模块为从底部激发样品的光电测试模块，激发光光源为可见光区光源，光照强度范围：0~2 x 1.4kW/m2 

1. 更换光照模块。（可参考加热模块） 

a) 关闭激光光源和控制器电源； 

b) 打开扫描器隔音罩，将扫描器拉出并固定； 

c) 将 holder 取下，并将扫描台上的连接线拔下； 

d) 用内六角螺丝刀旋松扫描台正面和侧面的固定螺丝； 

e) 将标准模块扫描台取出后，更换成光照模块扫描台； 

f) 先将加热模块扫描台电源接线从通孔，在固定扫描台底座的时候，可以轻轻按压四周的金属圈进行固定，不

要按玻璃片，以防损坏玻璃片； 

g) 安装好光照模块扫描台后，连接电源接线； 

h) 打开控制器电源和激光光源； 

  

2. 固定样品时需要选择中空的样品台，以便光从底部照入。开启软件，打开任一操作模式； 

3. 在软件项目栏选择 AFM Controls → Environmental Panel，进入操作页面； 

 

光照模块扫描台 

电源接口 电源接口 
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4. 在 Controls 一栏中的 Mode 切换至 On，光照开启。在 Heater Output 输入百分比数值即可调节光照强度，之后即

可进行其他模式的测试； 

5. 测试完成后，将 Mode 切换至 Off，光照关闭。 

 

十五、 压电模式（PFM） 

十六、 电化学模式 

此模式需要测试可联系管理员 

 

十七、 数据处理 

1. 在软件页面主目录 AFM  Analysis 选择 Browse saved data→在跳出的 AR Load Path 面板中点击 Browse，确认需

要打开的文件夹→点击 That’s it，在 Browse 面板中即可观察到打开的数据；  

 

2. 如果要更改路径，点击 Browse 面板的 Change Directory 按钮；通过 Vertical Number 和 Horizontal Number 可以设

置缩略图的显示数量，图标默认显示的是 Height 图像，也可以通过 Image Data Type 下拉菜单，设置为别的图

像； 

 

3. 在 Browse 面板中，双击需要处理的缩略图，出现如下信息面板；1 为扫描范围、2 为偏移量、3 为色阶显示、4

为自动调整、5 为图像颜色选择、6 为存储的图像通道、7 为处理功能选择； 
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4. 点击 Commands，根据需求，选择处理功能；常用的为 Display Panel，Modify Panel（可进行表面展平，过滤，

标记等处理），Analyse Panel （可进行粗糙度测量，截面截取） 

5. Modify Panel 功能介绍。点击图像上方的 M 按钮，打开 Modify 面板或者从 AFM Analysis 菜单打开 Modify Panel； 

 

a) Modify 面板最常用的功能是 Flatten 和 Planefit，它们的作用是拉平形貌图像；  

b) Flatten 是将 AFM 的扫描线逐一对齐，当前软件中，高度图像默认经过了 1 阶 Flatten 处理；Flatten 是逐行

调平、对齐，类似于对每条线分别做 Planefit； 

c) 选中所要处理的图像和通道→选择合适的 Flatten Order→点击 Flatten→如果效果不好，可点击 Undo Flatten； 

 

d) Planefit 是将形貌图整体调平，消除图像的倾斜；鼠标选中所要处理的图像和通道→Planefit Order 选择 1，

消除图像的倾斜→点击 XY； 
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e) Mask 是遮住不平整的区域，让 Flatten 只作用于平整的区域； 

 



 

 

 39 / 45 

 

f) 方法一：我们可以设置一个阈值，所有高度值高于（或低于）阈值的点，都被 Mask 遮住→拖动直方图中的

竖线（左图红色箭头）来设置阈值，或者直接输入一个 Threshold 数值→当 Inverse 勾上（左图黄框），高于

阈值的点会被 Mask 遮住。如果 Inverse 不勾上，低于阈值的点会被 Mask 遮住； 

g) 方法二：算法生成，选择算法（红框）→再点击 Calc Mask（黄框）→比较常用的是 Iterative 算法； 

 

h) 方法三：手动绘制，点击 Exclude Mask→图像的左侧出现画图工具（黄框），选择一种→画好图形（红色圆

圈）→点击 Make Mask→若要消除，点击 Reset Mask； 

 

i) Erase 可以用来消除图像中零星的跳线；点击 Draw Lines→在图像中选择坏线（选错了可以 Clear Lines）→

点击 Erase Lines，要撤销操作，点击 Undo Erase； 

 

j) 按时以上对图像的处理（Flatten、Planefit、Mask），都只对内存中的数据生效，硬盘中保存的数据不受影响。
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重启软件后打开数据，依然是处理之前的样子，要保存对图像的处理，可以选择 Commands 下拉菜单的 Save 

Image（覆盖原数据），或者 Save As …（数据另存为）； 

 

k) 是否 

6. Analyze Panel 功能介绍。数据分析的功能主要在 Analyze 面板，点击图像上方的 A 按钮，打开 Analyze Panel 或

者从 AFM Analysis 菜单打开 Analyze Panel； 

 

7. 常用的数据分析工具：Roughness（粗糙度等统计值）、Section（截面线）、Histogram（直方图）。图像的倾斜会影

响粗糙度值，因此适当的数据处理（用适当的 Flatten 或 Planefit 消除倾斜）是数据分析的前提； 

8. Roughness 页面。Max / Min：数据点中的最大值/最小值；Avg：数据点的平均值（1 阶 Flatten 或 Planefit 之后，

Avg 变为 0）；Percent：未被 Mask 覆盖区域所占的比例；Full Image 那一栏的 Percent 永远是 100%；Area：样品

表面积；Area %：样品表面积相比扫描范围多出来的比例；（样品表面不平整，表面积相比扫描范围会更大）； 
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9. Section 页面。Section 用来读取图像在一条线上的数据，对于形貌图来说，就像做了一个截面。点击 Draw→在图

像上画一条线，出现截面线→拖动两个光标可以改变线的位置→点击 Clear 可以删除截面线。Mode 有两种，Line

（直线）和 Free Hand（自由轨迹）；在 Line 直线模式下勾上 Full，截面线贯穿图像；Angle 为 0 是最安全的，即

便 Flatten 引入了假象，对截面线影响也不大；增大 Width，截面线变宽，有平均的效果，数据可能更平滑； 

 

10. Histogram 页面，即直方图，可以描述数据的分布情况。 
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11. 点击 Make New Histogram，观察数据分布情况。点击 Commands → Layout，可将直方图导出到 Layout；点击 Edit，

打开的表格是 AFM 图像的数据点，不是直方图的数据点； 

 

12. 对于层状、台阶样品，Histogram 可以用来测量层的厚度；Ctrl+I 调出 Cursor，放在两个峰上面，两个峰的 dX 就

是膜的厚度。 
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13. 3D 图像，对于形貌图（高度图和 Z Sensor 图），软件也可以生成三维渲染图像；点击图像上方的 3D 按钮，就会

生成 3D 图像。鼠标左键旋转模型，右键改变光照角度； 

 

14. 伴随 3D 图像出现的是 Master ArGL Panel，用于设置 3D 图像；Axes 子页面中 Show Axes 和 Axes Labels 选项调

节 XYZ 标尺的显示，Display 子页面中 ColorMap 和 Color Bar 选项设置颜色表和标尺； 

 

15. View 子页面还有一些有用的设置：选择 Offse，可以在窗口内平移 3D 模型（等用于 Shift+鼠标左键拖动）；选择

Spin，可以让模型自动旋转；选择 Color Scale，设置颜色表的 Range 和 Offset； 

 

16. 相比用颜色代表高度，3D 形貌图更为直观，3D 图像可以通过光影，帮助我们观察样品表面的细节。 3D 图像的

颜色可以用来代表非形貌信息，例如力学性能，电学性能等。Surface 下拉菜单选择数据→Data Type 选择 Height

通道→Color 方框勾上，数据和 Surface 相同→Color 的 Data Type 选择 Current 通道→点击 Do It。 
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17. 3D 图像不能用 Save Graphics 导出；用菜单栏 Edit → Export Graphics 导出。 

18. 数据保存。导出图片，选中图像，菜单栏 File → Save Graphics→Format 选择导出的格式→Resolution 选择分辨率

（可设置 DPI）→点击 Do It，设置导出的名称和路径； 

  

19. 导出数据。 AFM 图像是一个个数据表格，数据可以导出。方法一：保存为文本文件， Commands 下拉菜单，

选择 ASCII Export→保存为 txt 格式→可以用 Excel 等软件从 txt 文件导入数据；方法二：保存为 csv 文件，

Commands 下拉菜单，选择 Extract Layer→Ctrl+J 打开命令行窗口，输入 edit layerdata 并回车→回车后会看到数

据表格（也可直接复制到 Excel）→选中数据表格，菜单栏 File → Save Table Copy→选择保存为 csv 格式（Comma-

Separated Values）； 



 

 

 45 / 45 

 

 

 

 

 


